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Глава 8

Построение проекта на уровне системы

В этой главе выполним анализ системы связи, использующей модуляцию типа (/4-DQPSK. Анализ кодера и декодера,  для реализации ее, выполнены в главе 6.  Рассматриваемая система будет включать как цифровые компоненты DSP, так  и аналоговые блоки радиопередатчика и приемника, а также модель линии распространения радиоволн. Таким образом, будет выполнена косимуляция на системном, верхнем уровне построения радиосистемы.
         Современные радиосистемы строятся так, чтобы с максимальной эффективностью использовать отведенную для неё полосу частот. Если  система использует полосу с максимальной эффективностью, тогда устойчивая связь достигается при меньших мощностях передатчика, меньшей чувствительности приемника, и лучших энергетических характеристиках. В таких системах основную роль играет блок, осуществляющий расширение спектра сигнала, т.е. модулятор. На приемном конце функцию выделения сигнала выполняет демодулятор.

8.1. Подсхема модулятора DSP
Откроем проект  \examples\Training\CommSys\CommSys_Lab8_prj и схему этого проекта «a_PI4DQPSK_Sys_New». Эта схема представляет собой источник битовых данных Data, модулятор (/4-DQPSK и несколько компонентов анализа характеристик модулируемого сигнала (рис. 8.1): Sink, EVM и др.
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Рис. 8.1. Система связи «a_PI4DQPSK_Sys_New» и блоки, копируемые в буфер

Выберем все компоненты между блоками «LogicToNRZ» и «QAM_Mod» (рис. 8.1) и скопируем их в буфер компьютера командой Edit> Copy/ Paste> Copy To Buffer.

Выполним команду  File> New… и создадим новую схему DSP с именем «b_DSP_Modulator».

Внесем скопированную часть командой Edit> Copy/Paste> Paste From Buffer на новую схему и сохраним ее под именем “b_DSP_Modulator”.

Поместим разделители ВЧ сигнала «SplitterRF» из библиотеки «Timed Linear» в схему (рис. 8.2) на выходы преобразователей  «FloatToTimed» в обоих каналах «I» и «Q».
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Рис. 8.2. Фрагмент выделенной на рис. 8.1 схемы DSP
Далее поместим в эту созданную схему компоненту UsampleRF из библиотеки Timed Linear и установим следующие параметры этого блока (рис. 8.3):

Type = SampleAndHold  (тип интерполяции)

Ratio = 10.

Разделители SplitterRF (рис. 8.2) помещены в схему, чтобы разделить сигналы, идущие на блок UpsampleRF и далее  по пути символьных сигналов “I” (рис. 8.4).


[image: image3.png]Up sampler for time domain signals:1

USampleRF Potameter Enty Mode
Instance Name [namef<staitstop>]) SampletincHold 5l
)
f [Zereinseton
Select Parameter PolyPhaseFiter
Linear
Standerd

InsetiorPhase=0
EvcessBW=05

[ Display parameter on schematic:

o T |

[T5pe - upsanping ieplaion bpe

o | | Cancel | Resel Help_|





Рис. 8 3. Диалог блока учащения выборок (преобразователь вверх)

Скопируем компоненту UsampleRF и поместим ее на выход другого разделителя «SplitterRF» в линии «Q» (рис. 8.4) .

Внесем в эту цифровую подсхему также порты, причем:

Port1 на входе подсхемы

Port2 на выходе подсхемы

Port3 на выходе I 

Port4 на выходе Q 
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Рис. 8.4. Внесение и установка параметров 
блока сэмплирования вверх b_DSP_Modulator
Отредактируем параметр компоненты модулятора QAM_Mod:

Power = -10 dBm  (можно впечатать «dbmtow(-10)»)
          Передатчик будет обеспечивать необходимое усиление для компенсации разности между величиной «old» равной +14.5 dBm и величиной «new» равной –10 dBm.

Сохраним проект c именем «b_DSP_Modulator».

Табл. 8.1. Параметры компоненты EncoderIQ
	E 1
	Величина
	Пояснение параметра

	RIn
	50.0 Ohm
	Входное сопротивление

	ROut
	50.0 Ohm
	Выходное сопротивление

	RTemp
	-273.15
	Температура

	SymbolTime
	Sym_time
	Длительность следования символов

	Delay
	0 sec
	Задержка

	Type
	PI/4 DQPSK
	Тип модуляции


Табл. 8.2. Преобразователь вверх для сигнала во временной области UsampleRF
	U3
	Величина
	Назначение 

	Type
	SampleAndHold

	Тип интерполяции преобразования вверх


	Ratio
	10


	Масштаб преобразования вверх

	Insertion Phase
	0


	Внесение фазы upsampling для выходных не-нулевых выборок, когда Type=ZeroInsertion

	ExcessBW
	0.5


	Расширение полосы фильтра с характеристикой типа поднятого косинуса, используя Type=PolyPhaseFilter

	RIn
	50.0 Ohm
	Входное сопротивление

	ROut
	50.0 Ohm
	Выходное сопротивление

	RTemp
	-273.15
	Физическая температура


Разделители сигнала добавляются, чтобы видеть опорные I и Q символы из проекта верхнего уровня. Эти идеальные, прямоугольные символы будут опорными символами, которые можно будет тогда наложить друг на друга и сравнить с демодулируемыми выходными символами.

Выборки Up-samples позволят этим опорным выходным сигналам иметь то же самое число выборок на символ, как и выходных символов, начиная с ветвей с фильтрами – поскольку пути с фильтрами будут сэмплироваться в 10 раз чаще.

8.2. Создание проекта на системном уровне

Выполним следующие шаги для создания проекта на системном уровне (Top Level Design).

8.2.1. Модулятор

Выполним команду File>New… и создадим окончательную систему DSP «c_Final_PI4DQPSK_Sys» (рис. 8.5).

Используем команды «Copy to Buffer» и «Paste From Buffer» для копирования:

-   источника данных  «Bits», 

· контроллера DF, 

· блока VAR
из схемы «a_PI4DQPSK_Sys_New» в схему «c_Final_PI4DPSK_Sys».

Поместим подсхему «b_DSP_Modulator» из библиотеки DSP в проект и присоединим его вывод  1 к источнику данных «Bits» .
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Рис. 8.5. Окончательная система _Final_PI4DPSK_Sys
Подключим разделитель SplitterRF из библиотеки «Timed Linear» к выводу 2 подсхемы «b_DSP_Modulator» (рис. 8.5).

Поместим также два элемента задержки DelayRF из библиотеки «Timed Linear» и соединим их к выводам 3 и 4  «b_DSP_Modulator». Установим параметр задержки:

Delay = 17*Sym_time.

Это ожидаемая задержка через систему равна 17 длительностей символов опорных импульсов и позволит увидеть опорные и выходные символы одновременно на одном сигнальном созвездии.

Поместим два параллельных сопротивления 50 ом на выходе каждого элемента  «DelayRF» и присоединим элементы «TimedSink». Сборник данных TimedSink  присоединяется к пути передачи данных I «Iref», а TimedSink соединяется к  пути Q  «Qref».

Соединим спектроанализатор FFTAnalyzer к верхнему выводу делителя SplitterRF и установим параметры:

Instance Name = Mod_Spectrum

Npoints = 1024

Window = HANNING.

Поместим параллельный резистор 50 ом на входе анализатора FFTAnalyzer (табл. 8.3), названного «Mod_Spectrum».

Табл. 8.3. Параметры спектроанализатора FFT Analyzer 

	Mod_Spectrum
	Величина
	Пояснение параметра

	Start
	 DF_Value
	Начальное время сбора сигнала

	Stop
	 DF_Value
	Конечное время сбора сигнала

	Time Unit
	 DF_Value
	Единицы времени

	Display Freq Unit
	 MHz
	Единицы частот 

	NPoints
	 1024
	Количество частотных точек

	NAverage
	 1
	Количество перекрываний

	Param
	 0.5
	Параметр

	Window
	 H A N N I N G
	Окно Ганнинга

	N Segments
	 1
	Количество сегментов

	Overlap
	 0
	Перекрытие

	Bias
	 BIAS_POWER
	Смещение мощности

	Display
	 dBm
	Единицы мощности

	Ref_Resistance
	 50.0
	Опорное сопротивление


8.2.2. Косимуляция системы с аналоговой схемой передатчика

  
В данном проекте (рис. 8.5)  будет использоваться готовая аналоговая схема передатчика. 

1. Поместим на схему передатчик «Transmitter» (рис. 8.6) из библиотеки подсхем A/RF Sub-networks. Соединим его с нижним выводом «SplitterRF». 

2. Элемент «EnvOutShort» в библиотеке «Circuit Cosimulation» включим на выходе передатчика, с параметром

OutFreq = RF_freq, с  единицами None
При косимуляции методом огибающей на выходе подсхемы A/RF должны быть установлены или компонента EnvOutSelector или EnvOutShort. Это позволяет характеризовать сигналы на выходе схемы в терминах I (t), Q (t), и Fc (t). 
         Как уже отмечалось, назначение элемента EnvOutShort состоит в выполнении  «последовательного соединения» между подсхемой и системным элементом на выходе. Таким образом, подсхема будет видеть входной импеданс системного элемента (рис. 8.5).

Назначение элемента EnvOutSelector состоит в «разрывании последовательного соединения» схемы так, что подсхема не будет видеть входной импеданс системного элемента.
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Рис. 8.6. Схема передатчика
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Рис. 8.7. Схема усилителя мощности Motorola_PA в схеме передатчика

3. Присоединим элемент SplitterRF к выходу элемента EnvOutShort (рис. 8.5).

4. Поместим спектроанализатор FFTAnalyzer и соединим его к верхнему выводу SplitterRF. Установите следующие параметры:

Instance Name = Xmit_Spectrum

Npoints = 1024

Window = HANNING.

5. Поместим параллельный 50 омный резистор на вход  FFTAnalyzer с именем «Xmit_Spectrum».

8.2.3. Канал распространения радиоволн

Поместим элемент антенны мобильного средства связи AntMobile (рис. 8.8) из библиотеки «Antennas & Propagation» и присоединим его к нижнему выводу SplitterRF. Установим следующие параметры:

Gain = 6 _dB

(усиление антенны)

X = 75 meter

(координата X, в единицах дистанции)

Y = 0 meter

(координата Y в единицах расстояния)

Height = 2 meter

(высота антенны, относительно плоскости XY)

SpeedType = km/hr
(единицы скорости)

Vx = 75


(X компонента скорости вектора движения)

Vy = 4


(Y компонента вектора движения)

Поместим элемент моделирования среды распространения PropNADCtdma из библиотеки “Antennas & Propagation”  и соединим его к выводу мобильной антенны AntMobile. Установим следующие параметры:

Type = NoMultipath

(тип распространения)

Pathloss = Yes


(включение потери в пути)

Env = TypicalUrban

(опции типа прибора)

Delay = 0



(относительная задержка (Type=TwoPath) по отношению к первому пути, в мксек)

Pwr = 0



(относительная мощность (Type=TwoPath) по отношению к первому пути, в дБ)

Seed :
(целое число для начала генерации случайных чисел)

Test : 




(тестовая точка для одного пути)

Поместим элемент AntBase из библиотеки «Antennas & Propagation» и присоединим его к выходу элемента  PropNADCtdma (рис. 8.8). Установим следующие его параметры:

Gain = 6 _dB.

(усиление антенны)

X = 1 meter

(X-координата)

Y = 5 meter

(Y-координата)

Height = 10 meter
(высота антенны относительно плоскости X-Y)
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Рис. 8.8. Фрагмент системы: антенна мобильной станции, модель пути распространения сигнала CDMA и антенна базовой станции

8.2.4. Приемник

Приемник, составленный из системных компонентов Ptolemy, имеется в библиотеке DSP. Поместим элемент «Receiver» в окно DSP и присоединим его с выходом антенны «AntBase». Рассмотрим содержание его на нижнем уровне (рис. 8.9).
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Рис. 8.9. Схема приемника

Этот проект приемника в целом такой же, как использовался ранее и включает смеситель (табл.8.5) и усилители (табл. 8.7). 
         Заметим, что источник (поставленный в качестве гетеродина) N_Tones позволяет задавать фазовый шум в dBc/Hz при различных частотных смещениях. Параметры фильтров Чебышева, используемого в приемнике, раскрываются в табл. 8.4, смесителя – в табл. 8.5, параметры гетеродина в табл. 8.6, усилителей – в табл. 8.7.

Табл. 8.4. Параметры цифрового фильтра BPF_Chebyshev_Timed
	Имя
	Величина
	Пояснение

	Num
	2 BPF_Сhebyshev Timed
	

	B2
	
	

	FCenter
	RF_freq
	Центральная частота

	Pass Bandwidth
	27 MHz
	

	Pass Ripple
	0.1
	Неравномерность в полосе пропускания

	Stop Bandwidth
	40 MHz
	

	Stop Atten
	40
	Затухание в полосе запирания

	N
	 5.0
	


Табл. 8.5. Параметры смесителя 

	Mixer RF
	
	ВЧ смеситель

	M2
	Type = LOminusRF
	Тип : с понижением частоты


Табл. 8.6. Параметры многотонового источника  N _ Tones
	N 2
	Величина
	Пояснение параметра

	Frequency1
	L O _ f r e q
	

	Power1
	dbmtow (7)
	Мощность источника

	Phase Noise Data
	" 10 - 60 100 - 70 10 00 - 80 10 0 0 0 -90 "
	Фазовый шум источника


Табл. 8.7. Параметры модуля усилителя Gain RF
	G 6


	Величина
	Пояснение параметра

	Gain
	dbpolar (50,0 )
	Усиление усилителя

	Noise Figure
	= 5
	Коэффициент шума

	GCType
	none
	Тип задания нелинейности

	TOIout
	dbmtow (33)
	Интермодуляция 3-го порядка

	dBc1out
	dbmtow(22)
	Точка сжатия усиления на 1 дБ


8.3.5. Демодулятор

Используем команды в главном меню ADS «Copy To Buffer» и «Paste From Buffer» для копирования всей части схемы за выходом QAM_Mod в  «a_PI4DQPSK_Sys_New» в схему «c_Final_PI4DQPSK_Sys». Соединим элемент SplitterRF с выходом приемника Receiver. Изменим имя спектроанализатора  “FFTAnalyzer” на «Recv_Spectrum».

Установим в измерителе «EVM» параметр «Start» (табл. 8.9):

Start = 19*Sym_time.

Окончательно система сбора данных должна выглядеть как на рис. 8.10.
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Рис. 8.10. Система сбора данных
     Сохраним проект и запустим моделирование (это занимает 20 минут). Далее выполним анализ результатов моделирования системы связи.

Табл. 8.8. Параметры демодулятора  new_DQPSK_PI 4 D e m o d
	D 3
	Величина
	Пояснение параметров

	RIn
	50.0 Ohm
	Входное сопротивление

	ROut
	50.0 Ohm
	Выходное сопротивление

	RTemp
	- 273.15
	Физическая температура резистора, C

	Ref Freq
	IF_freq
	Промежуточная частота

	Symbol Time
	Sym_time
	Временной интервал входного символа

	Excess Bw
	0. 3 5
	Коэффициент расширения полосы фильтра с характеристикой приподнятого косинуса; 0 <= ExcessBw <= 1


Табл. 8.9. Параметры элемента Err Vec Meas
	E 2


	Величина
	Пояснение параметров

	Start
	19 * Sym_time
	Начальное время для записи данных

	Stop
	Tstop
	Конечное время для записи данных

	Time U n i t
	sec
	Единицы времени

	Symbol Time
	Sym _ time


	Время длительности символа

	Measurement_Type
	ERROR_VECTOR_MAGNITU DE
	Опции для типа расчета в EVM

	Symbol_Burst_Length
	6 4


	Число символов в пачке для расчета EVM

	Modulation_Type
	PI4_DQPSK_MOD

	Опции для типа модулирования входного сигнала

	Plot
	Yes
	Черчение графика 


8.3. Анализ результатов моделирования

8.3.1. Расчет характеристики EVM
Откроем окно DDS и увидим в таблице результаты расчета ошибки вектора сигнала EVM (глава 7). [image: image11.png]


Заметим, что EVM имеет ухудшение на 3.4%, относительно исходной величины E2=0.4%, но еще удовлетворяет спецификации ошибки 12.5%.

8.3.2. Сигнальное созвездие

Введем необходимые уравнения (рис. 8.11) и выведем график  сигнального созвездия принятого и демодулированного сигналов.
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Рис. 8. 11. Сигнальное созвездие в окне вывода данных

Заметим, что имеется некоторое ухудшение каждого фазового состояния (размытие точек состояния на фазовой плоскости).

8.3.3. Расчет спектра
1. Выведем модулированный спектр «Mod_Spectrum», на выходе «DSP Modulator» (рис. 8.10). Он показывается на рис. 8.12.
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Рис. 8.12. Спектр сигнала на выходе модулятора

2. Выведем спектр передатчика, «Xmit_Spectrum», на выходе A/RF передатчика «Transmitter» (рис. 8.13)
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Рис. 8.13. Спектр на выходе передатчика

3. Выведем также спектр на выходе приемника, “Recv_Spectrum” (рис. 8.14).
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Рис. 8.14. Спектр на выходе приемника

-

8.3.4. Расчет мощности в точках системы

Функция  «spec_power» рассчитывает общую интегральную мощность спектра, в dBm,  получаемого сборником сигналов «FFTAnalyzer» и или сборником «SpecAnalyzer»:


spec_power(sink name, min freq in MHz , max freq in MHz).

Сборник сигналов может носить имя FFTAnalyzer или SpecAnalyzer.

Границы частот даются в MHz и могут отсутствовать. Спектр (который можно увидеть с помощью сборника данных) показывается во всем частотном диапазоне, если эти границы не предоставлены.
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Рис. 8.15. Встроенные функции расчета мощности в окне вывода данных

Поместим маркеры на графике спектра в окне данных, размещая их на рассматриваемых частотах, как показано на рис. 8.16, и используя функцию «spec_power» для интегрирования мощности спектра между маркерами. 
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Рис. 8.16. Функции расчета мощности в заданной полосе спектра

Результаты расчета, показанные на рис. 8.17, те же самые, как и в предыдущем случае. Как и ожидается, мощность сигналов в спектре вне указанных маркеров, незначительная, по сравнению с мощностью в полосе частот между маркерами. Но в общем случае это не верно. Этот метод может также использоваться, например, для расчета характеристик отношения мощностей в каналах, а также параметра ACPR (рис. 8.17).
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Рис. 8. 17. Расчет мощности в точках полосы спектра, заданных метками

8.3.5. Сравнение символов Iref и Iout
Выведем на один график опорные символы Iref, и выходные символы Iout (рис. 8.18).
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Рис. 8.18. Временной процесс опорного сигнала Iref  и сигнала Iout
Используя возможности выделения части функции в окне, более детального, мы видим график рис. 8.19.


[image: image20.png]time, msec





Рис. 8. 19. Укрупненная картина временного процесса

Заметим, что опорные и выходные символы на рис. 8.19 синхронизированы по времени и соизмеримы по амплитуде друг с другом.

Итак, в этой главе была создана и проанализирована на цифровом уровне система сотовой связи. На последнем этапе система включила подсхему DSP как часть модулятора и аналоговую подсхемы передатчика и приемника. Это показывает возможности ADS предоставить общую интегрированную среда для анализа DSP характеристик системы и инженерного проектирования интегральных микросхем.

В окончательном проекте были выполнены требования к параметру системы EVM = 12.5 %.

Сигнальное созвездие показывает искажения сигналов, вносимые передатчиком, антенной и средой распространения, и приемником. Общая суммарная мощность из модулятора, передатчика и приемника были рассчитаны из характеристик спектра. Опорные символы и символы на выходе демодулятора были выровнены по времени так, чтобы можно было их сравнить и оценить такие образом реальное ухудшение, вносимое системой обработки данных. 
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